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Chapter 1: What is WID? 
 

1.1 About this Version 

WID is a PC-based simulator to predict and monitor injection well performance (well 
injectivity and induced fracture growth) in water/polymer injection wells from inception to 
abandonment. 

  

1.2 Current Capabilites 

The current version has the following features/modeling capabilities: 
 

1.2.3 Vertical Wells 
WID can model the injectivity and induced fracture growth in vertical injection wells. The 
vertical wells in WID can have the following options – 1) open-hole (with or without a 
hydraulic fracture), 2) cased-hole and perforated (with or without a hydraulic fracture) and 
3) frac-packed injector with detailed plugging of the gravel in the frac-pack and widening 
of the frac-pack. However, this more comprehensive option for frac-packed injectors does 
not allow any lengthening of the frac-pack. For vertical wells, 3D fracture growth can also 
be modelled for evaluating height containment issues. 
 
Model Description Summary: The model is capable of handling injection into non-
communicating multi-layered reservoirs. The present version has the capability to model 
thermally and hydraulically induced fractures (with asymmetric growth of the fracture in 
case of a dipping reservoir) around a single, vertical or horizontal well. The model predicts 
the initiation and growth of a two-winged fracture in the near wellbore region due to the 
combined influence of injection pressure, pore pressure and thermal stresses due to the 
injection of cold water, and an additional pressure increase due to well and fracture face 
plugging. The modeling of fracture initiation and propagation is based on the PKN model 
(Perkins and Gonzalez, 1985). The fracture face plugging due to particle filtration and the 
resulting filter-cake build-up on the fracture face are modeled using filtration theory 
(Rajagopalan and Tien, 1976; Wennberg and Sharma, 1997). Fracture growth and fracture 
face plugging are modeled as dynamically coupled phenomena, with the continuously 
growing fracture face area being plugged with the influx of injected particles. 
 

1.2.2 Horizontal Wells 
WID can model the injectivity and induced fracture growth in horizontal injection wells. The 
horizontal wells can be open-hole or cased-hole with perforations. A model similar to that 
proposed by Joshi (1988) is used to estimate the injectivity. In this model, the 3-
dimensional flow is divided into two 1-dimensional flows. The induced fracture growth can 
have two orientations: 

 Transverse 

 Longitudinal 
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1.3 Injectivity Calculation 

WID determines how the injectivity in an injection well changes with time as a result of 1) 
plugging due to particles present in the injection water, and 2) mobility changes in the 
reservoir. The simulator utilizes the following steps to accomplish this: 
 

 Determine the concentration of deposited particles around the well as a function 
of time and distance from the well, (by solving the filtration equations in that 
region).   

 Calculate the transition time, i.e. the time where an external cake starts building 
on the wellbore. Prior to the transition time, only internal filtration is considered 
(reduction of formation permeability).  After the transition time is reached, only 
external cake build-up is considered. 

 Calculate the reduced permeability of the near-well zone or the near fracture zone 
due to deposited particles. 

 Determine how this near-well damage changes the injectivity of the well by 
calculating the additional pressure drop due to this region. 

 Calculate the change in minimum horizontal stress due to thermal stresses and 
pore pressure changes as water at temperature T1 is injected into a formation at 
temperature T2. 

 Iterate to calculate the length of the damaged fracture by properly accounting for 
fracture plugging and changes in the stress field. 

 Calculate the distribution of flow and fracture growth in non- communicating multi-
layered reservoirs with a vertical well. 

 

1.4 Chapters overview 
This manual, which focuses on the effective use of WID, is organized as follows: 
  
WID: Software User Guide  
Section 1 is the User Guide and describes how to run the WID software. The user’s guide 
assumes that you have a general knowledge of the windows operating system. 

 Chapter 2 covers the installation of WID. 

 Chapter 3 is a quick tutorial on WID. 

 Chapter 4 covers the common input variables. 

 Chapter 5 discusses loading and saving of data 

 Chapter 6 describes the units used in the simulator. 
 
WID: Technical Documentation 
Section 2 is the description of the mathematical models that are used to calculate the 
injectivity and fracture length. For a description of the underlying mathematical models, 
you can also refer to the key references listed below: 
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Chapter 2: Installing WID 
 

2.1 Installation 
 
WID is a 32 bit application that runs on Windows 7, 8 and 10. To install it, double click the 
Setup.exe program.  
 
Follow the instructions that appear on the screen. WID will appear on the program menu 
as WID. 

 
 

2.2 Using Non-English Versions of Windows 

If you are using a non-English version of Windows and the program is crashing, it is 
possible that it is due the regional settings. Change the settings on your computer to 
English. To do so, 

 
1. From the Windows Start menu select Settings 
2. Select the Control Panel 
3. Select the Regional Settings folder and select the Regional Settings Tab. 
4. Select English (United States) from the Combo Box 
5. Restart the computer for the settings to take effect 



WID – User Guide 

 

10 

Chapter 3: Getting Started 
 
This chapter provides a summary of the process and steps involved in setting up a simulation in 
WID. A more detailed explanation is provided in the following chapters of this text. 

 

3.1 Main Tab 

On starting WID, the first window that opens is the Main Tab, which is the first step for 
setting up the simulation.  

 

 
                                      

3.2 File Options 
 
The user may want to:  

 Create a New Input File : Click File>New 

 Open an Existing Input File : File >Open 

 Import .dat input file : File>Import 
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3.3 Setting up a simulation 
 

3.3.1 General Information:  
 

In this section the user must may enter the details of the project such as Field Name, well 
location and project description. Well Type must be selected from the drop down box which 
gives options for vertical, horizontal and linear core flood injection. 

 

 
  

3.3.2 Well Data: 
 

The following section is important for setting up the correct default input parameters for the 
simulation. For each well type, there are several Completion Type options which the user 
must choose from: 

 

 

 

 

 

 

 

 

 

 Choose one of the options for the completion type compatible with the Well Type 
selected. 

 The input data window will appear filled with the default input data and modify the 
required input parameters according to the selections made by the user in the 
above options.  

 Input the corresponding well data and click the ‘Layers’ tab. 

 

3.3.3 Layers Tab: 
 

The layers tab allows the user to add multiple layers in the simulation. However, only one 
layer can be perforated or have fracture growth.  

Vertical Well  

 
 

Horizontal Well 

 

Linear Core Flood Injection - 
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 New Layers can be added or deleted using the green ‘+’ button and red ‘x’ button 
respectively. Upon click the ‘+’ button the following dialogue box appears, which also 
allows the user to copy layer properties from a pre-existing layer. 

Note : Providing a unique layer name is necessary  

 

 Layer and Formation properties take the basic inputs for the formation, and whether the 
current layer is perforated or not. The user must select the check box for ‘Is layer 
perforated’ for the layer in which the induced fracture propagation is to be modelled. For 
the Damage options the user can decide to use the in-built auto evaluation functionality, in 
case of unavailability of sufficent relevant data.  

Note : Only one layer can be perforated at a time for the 3-D simulations. The program will not 
run for more than one layer perforated.  
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 Fluid properties :  

o Physical properties 

o Thermal Properties 

o Fluid Flow properties 

 Rock properties : 

o Rock Mechanical Properties 

o Rock Thermal Properties 

The above properties are input of the second half of the layers section. Default values are provided 
for each parameter. Two unit systems are provided in the interface : 

 SI units 

 Field units 

Click on Tools>Settings>Default Units to change units or simply choose from the drop down box 
located on top of the window as shown below : 
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3.4 Simulation Run Button 
 

 

Click the play button (circled in red in figure) after you are sure you want to run the 
simulation.  After a few seconds to few minutes, depending on the injection period and type 
of completion under evaluation, the results window will appear.  
 
The Charts Tab shows plots which can be selected from the drop down box for the 
parameters shown in the given figure. WID log, Summary, Errors and Notification tabs 
appear on the bottom-left of the results window which can be used to check runtime 
messages. 
 
Note: Fracture Contour Plot is only for 3-D simulation. 

. 
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*Results shown in the above plots are for demonstration purposes only 

Plot manipulation options: 
 

 Right click and drag on plot axis will scale the axis values accordingly 

 Hovering the pointer over the plots gives the x, y coordinates. 

 The mouse-wheel can be used to zoom-in and zoom-out of the plot. 

 Holding mouse-wheel button and drawing a rectangle zooms in on that portion of the 
plot. 

Close the Results window. Try to change some input data in the input windows to see how it affects 
the result for any sensitivity analysis. 
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Chapter 4: Input Windows 
 
The WID input frames are organized into four tabs, containing the Main, Layer, Injection and History 
data. The main tab contains the general information of the simulation and the well completion type 
which further decides the input parameters required for the particular case. The input options under 
these tabs are described in this chapter.  
 

 
 

4.1 Main: Well Data  
 
The ‘Well Data’ input section, has several fields. Each is described below. 

 
 4.1.1 Completion Type 
Vertical well: The program allows 4 options for vertical injection wells: 1) open-hole injector (with 
or without a hydraulic fracture), 2) perforated injector (with or without a hydraulic fracture) and 3) 
frac-packed injector with in-depth modeling of the frac-pack and 4)3-D Fracture Growth. The fracture 
in all three is assumed to be vertical with a constant height equal to the layer height.  

 In the first two options, a 2-D fracture growth is modeled with widening and lengthening of the 
fracture. The fracture initiation and growth is based on 2-D PKN constant height model with 
fracture growth caused by the damage due to solids in the injected fluid and due to any thermal 
stresses. Note that the model for the hydraulic fracture in the first two options does not explicitly 
model the proppant pack but considers it to be an infinitely conductive fracture.  

 The third option, with the frac-packed injector option, allows for plugging of the proppant in the 
frac-pack and is a comprehensive model for frac-packed vertical injectors. However, the frac-
packed injector option run results are valid only up to a few months or a maximum of few years 
as it allows only widening of the frac-pack but no lengthening.  

 The fourth option, allows for 3-D fracture growth and can capture height growth of the fracture. 
If late time lengthening of the frac-pack is to occur and modeled, the first two options allow an 
approximate model for the frac-pack as an infinitely conductive fracture that can lengthen with 
time.  

The downside of the options without frac-pack is that they do not allow plugging of the proppant in 
the frac-pack and assume uniform plugging of the fracture faces. Details of these models are 
discussed in the ‘Technical Documentation’ section later in this manual. The following window 
shows the three options for the vertical injectors: 
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Well radius 
The radius of the well. Units:  cm [metric], inches [field].  

 
Drainage radius 
For a single production or injection well, this radius is the distance over which fluid flow is impacted 
by the well.  This is determined by well spacing.  In a reservoir that has both production and injection 
wells, it will typically be half the distance between the production and the injection well. The results 
are relatively insensitive to drainage radius.  Units:  meters [metric], ft [field].  
1 m=3.28 ft. 

 
Horizontal well: The program allows for a open-hole injector (with or without a hydraulic fracture) 
and a perforated injector (with or without a hydraulic fracture) with two fracture growth orientations 
(longitudinal and transverse). In the longitudinal fracture growth option, a fracture is grown upward 
and downward vertically aligned with the horizontal well with the entire wellbore fractured. The 
height of the fracture is assumed to be the horizontal well length with maximum length allowable is 
equal to the layer height. Once the fracture reaches the layer upper or lower bound, the results are 
not valid thereafter. In the transverse fracture growth option, a vertical fracture is grown from the 
center of the horizontal well perpendicular to the well with fracture height constant and equal to the 
layer height.  

 
 

The longitudinal and transverse options provide limiting cases for fracture length. The transverse 
case usually provides an upper bound to the fracture length while the longitudinal case provides a 
lower bound to the created fracture length. Fractures are likely to be oriented at some angle to the 
horizontal wellbore and their response will lie somewhere in between these two limiting cases. The 
following window shows the four options for horizontal injectors: 

 
4.1.2 Parameters for Perforated Completion 

 
Perforation radius 
Perforations are assumed to be cylindrical in shape. Typical range: 0.25 – 0.5 inches.  Units: cm 
[metric], inches [field]. 1 cm = 0.3937 inch 

 
Perforation Length 
The length of the perforation is from wellbore wall to perforation tip into the formation. This can be 
estimated from specifications for the shaped charge (API RP53).  Units:  cm [metric], inches [field]. 
1 cm = 0.3937 inch 
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Perforation Shot Density 
Number of perforations per unit length of the perforated well interval.  Typical value: 8 shots/ft. Units: 
shots/m [metric], shots/ft [field]. 1 spm = 0.3048 spf 

 
Well Apparent Radius 
The flow through perforations is modeled as an additional pressure drop in the reservoir. An 
equivalent open-hole well with an apparent well radius based on the perforation radius, length and 
the shot density is calculated for the cased and perforated hole (Eq. 2.47, chapter 2, technical 
documentation). 
 

4.1.3 History Matching 
 

WID can use historical field data for its simulation. WID allows user to import either: 

 Historical total injection rate to the well 
o To import injection rate, “Read and Plot field total injection rates” option must be 

selected.  

 Historical total injection rate to the well and the boundary reservoir pressure of each layer 
o To import injection rate and reservoir pressures, both options “Read and Plot field 

total injection rates” and “Read Plot field historical average reservoir pressures 
for all layers” must be selected.  

 

 
 

The field data in text file can be imported by  button. The text file must be in a format 
with a header row and data from the second row. From the second row, the first column should be 
time in days and second column must be the total injection rate in the unit of barrel per day. When 
the reservoir pressures are imported as well, the third column and on should have reservoir 
boundary pressures in psi from the top to bottom layers respectively. The imported data can be 
verified in the “historical_q.txt” sub-tab of the “History Input” tab as below. 
 

  



Chapter 4: Input Windows 

 

19 

 
User can also import historical injectivity and/or historical bottom hole pressures. The imported data 
for injectivity and bottomhole pressures are not used as simulation input, but are only used to 
compare with simulation results in x-y plots. “Read and Plot field historical injectivity” and/or “Read 
and Plot field historical bottom hole pressures” options are to be selected as necessary. 

To import historical injectivity and BHP data,  and  buttons must be 
used to choose text files. The format of the text files must have a header row, and data from the 
second row. The fist column needs to be time in days, and second column historical injectivity 
(bpd/psi) or BHP (psi). Once data files are imported, they can be displayed in the “Historical Input” 
tab in a spreadsheet format.  
 

4.1.4 Skin Calculator 
 

If the well has skin (reduced near-well permeability) from drilling workover or completion operations, 
this must be accounted for when determining the initial injectivity of the well.  This skin will influence 
the behavior of the injection well until a fracture is induced. First, the well has a higher flow resistance 
due to this skin.  This means that additional flow resistance added e.g. by an external filter cake in 
the well has less relative effect on the injectivity.  A filter cake that reduced the injectivity in an 
undamaged well by 50% may only reduce the injectivity in a damaged well by 10%. 

  

 
 
WID accounts for this by allowing the user to specify initial skin.  This can be done in three 
different ways: 
 

i. “Downhole Pressure” option: Downhole flowing pressure and average reservoir 
pressure is specified.  Skin values are calculated on the basis of initial down hole 
pressure and formation data. 

ii. “Damage Skin” option: The damage skin is specified directly.  Steady-state downhole 
pressure is calculated. 

iii. “Surface Pressure” option: Surface initial pumping pressure, reservoir pressure and 
injection tubing data are specified.   Downhole pressure and skin values are calculated 
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based on pumping pressure, hydrostatic pressure head (gh) and frictional pressure 
drop. 

 
The friction factor (f) inside well bore tubings (steel pipes) is calculated using Chen’s correlation 
(Economides and Hill, 1992): 

 
0.8981

1.1098

Re Re

5.04 7.149
1/ 4lg lg

3.7065 2.8275
f

N N

 
    

      
     

 

 
Here, NRe = lud/m and  is the roughness coefficient for the steel pipe, typically between 0.001 

and 0.003.  When the friction coefficient is known, the frictional pressure drop is given as: 

                                                        
dLufp wlrf /2 2

 
 
Caution 
Since this Skin Calculator section in the program is designed to provide initial skin to the main 
WID simulation, calculation in this section is mostly independent of the rest of the program. 

Whenever any parameter is updated in this section,  button must be clicked to 
update the result.  
 

 

4.2 Layers 
 
In WID, one can have as many as 10 layers for vertical wells. Note that the model assumes no cross 
flow between layers. The basic parameters for each layer are displayed in the grid in the bottom of 
the input frame. Note that although the name layer may be a misnomer for lab cores, the properties 
of the rock need to be entered in the layer data. For horizontal wells and cores, only one layer is 
allowed. 
 
Adding a Layer 
To add a new layer, click the green ‘+’ button located on top-left corner. This opens the ‘New Layer’ 
dialogue box. The layer is inserted at the bottom by default. The layer number of the layer to be 
added or in other words the position where the new layer is added can be adjusted by clicking on 
the arrows next to the number.  
 
Note: The layers need to be added in the sequence of occurrence with the shallowest layer entered 
first and the deepest layer entered last. The vertical scroll bar is provided to change the sequence 
for the new layer to be added (default sequence is addition to the bottom). 
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Clicking OK brings up the Formation and Filtration Properties window. 

 
Removing a Layer 
To remove a layer, select the appropriate layer in the Layer display grid and press the red ‘x’ 
button on top left corner. The last layer cannot be removed.  
 
4.2.1 Formation and Filtration Properties 
 

 
   
Layer Name 
The layer name is important and needs to be entered. The fluid and reservoir properties in the 
Reservoir Fluid Rock Thermal Fracture Data frames are displayed and set based on the layer name 
entered here.  
 
Top of Layer 
Enter the depth to the top of the layer.  
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Bottom of Layer 
Enter the depth to the top of the layer.  

 

Perforated 
This option is only available in perforated completed well options and not in the Open-Hole 
completion well option. By default all layers in the cased and perforated well option are assumed to 
have perforations. However, if one or more layers are not perforated then injected fluid will not enter 
directly into this layer from the wellbore. Uncheck the box in this case. Approximate vertical flow is 
modeled that will result in flow entering into this layers from the other perforated layers. Refer to 
Chapter 5 in the Technical Documentation section for details.  
 
Top of Perforations 
This option is only active in the cased and perforated well completion.  
 
Bottom of Perforations 
This option is only active in the cased and perforated well completion. However the depths of the 
perforations are not used in any calculation. 

 
Horizontal permeability  
The permeability in the horizontal plane. The horizontal permeability is assumed to be isotropic in 
the horizontal direction. 
 
Vertical permeability 
The permeability in the vertical plane is needed for horizontal wells and for unperforated layers in 
vertical wells. 
 
Porosity 
The porosity of the layer, must lie between 0 and 1. 
 
Height/Vertical Thickness 
The formation height. WID assumes a uniform height for each layer/formation. If the height varies, 
the height in the near well area is most appropriate. If the layers are dipping, the formation height 
refers to the layer thickness (minimum distance between the layer boundaries). 
 
Eccentricity and Well Length(Horizontal Wells only) 
This is enabled for the horizontal well only.  This is a ratio = e / (h/2), where h is the formation 
thickness and e is the vertical distance from the center of the formation to the axis of the horizontal 
well. A value of 0 means the well is in the center of the layer with no eccentricity and a value of 1 
means that the well is at the top or bottom of the formation. 

 
 
 
 
 
 
Note: The layers need to be added in the sequence of occurrence with the shallowest layer entered 
first and the deepest layer entered last. However the depths of the layers are not used in any 
calculation. 

h 

e 
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4.2.2 Internal Damage Parameters Frame 
 
This frame contains the parameters needed to calculate internal damage due to particle 
deposition. The default is for WID to evaluate all these parameters, but the user can change them. 
 
Internal Damage Check Box 
If the internal damage period is very short or the user knows that an external cakes starts to form 
at once, the program can be forced to skip the internal damage period by leaving this box 
unchecked. Parameters related to internal damage and transition time are then irrelevant. This 
option is currently inactive. Contact Dr. Mukul Sharma if needed. 
 

Damage factor,  
The permeability reduction as a result of particle deposition is calculated on the basis of the Kozeny 
equation (SPE 38180). Changes in porosity and specific surface area are accounted for.  
 
Increased tortuosity may cause a larger permeability reduction than predicted by this equation. This 

extra damage can be accounted for by specifying a positive value for the damage factor, . The 

default value for  is 0. 
 

Filtration coefficient,  

The filtration coefficient () describes the rate of particle deposition via the equation: 

vc
dt

d



  

where  is the deposited concentration, v is the velocity and c is the suspended concentration. The 
filtration coefficient can either be automatically evaluated or entered for oil and water. It depends on 
a large number of parameters. In WID 7.2, the filtration coefficient is calculated on the basis of a 
correlation by Rajagopalan and Tien, which assumes negligible double layer repulsion between 
particles and grains. For typical water injection conditions, the correlation predicts values in the 
range of 0.1 to 10 cm-1. The calculated value is shown in the results window.  
 
Formation grain size 
The grain size is evaluated by the Kozeny equation, using the formation permeability and porosity. 
The grain size obtained form this equation can sometimes be incorrect for extreme cases, and the 
user can specify a value obtained from thin sections or grain size analysis. 

 

4.2.3 Reservoir Fluid, Rock, Thermal and Fracture Data 
 
PHYSICAL PROPERTIES 
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Density of mobile fluid (oil/water) in reservoir 
This is the density of mobile fluid in an undisturbed formation.  The mobile fluid is water in case of 
injection into aquifers and oil in case of oil reservoirs.  Units:  kg/meter3, lbm/cu ft. 
 
Density of connate water in reservoir 
This is the density of the connate water in the reservoir. Units:  kg/meter3, lbm/cu ft. 
 
Compressibility of connate water 
This is the compressibility of water.  Units:  1/Kpa, 1/psi 
 
Compressibility of mobile fluid (oil/water) in reservoir 
This is the compressibility of the mobile fluid in an undisturbed formation.  This is water in case 
injection into aquifers and oil in case of oil reservoirs.  Units:  1/Kpa, 1/psi 
 
Viscosity of mobile fluid (oil/water) in reservoir 
This is the viscosity of the mobile fluid in an undisturbed formation.  This is water in case injection 
into aquifers and oil in case of oil reservoirs.  Units:  Pas, cp.  
 
Viscosity of connate water 
This is the viscosity of the connate water at the reservoir temperature.  Units:  Pa-s, cp. 
 
THERMAL PROPERTIES 
 

 
 

Reservoir Temperature 
This is the initial temperature of the undisturbed reservoir. Units:  0C, 0F 

 
Injected Water Temperature 
This is the temperature of the injected water. Units:  0C, 0F 

 
Specific heat of Injected Fluid and Connate Water 
This is the specific heat of water. Note this value is also used for the specific heat of injected fluid 
and the connate water. Units: KJ/Kg-K, Btu/Lbm. 

 
Specific heat of mobile fluid (oil/water) in reservoir 
This is the specific heat of the mobile fluid in an undisturbed formation.  This is water in case injection 
into aquifers and oil in case of oil reservoirs. 

 
FLUID FLOW PROPERTIES 
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Residual mobile fluid (oil/water) saturation in reservoir 
If the water is being injected into an oil bearing zone, then this is the residual oil saturation.  In the 
case of injection into an aquifer, it is 0.   
 
Initial water saturation 
This is 1 for injection into aquifers and the appropriate value for injection into oil bearing zones. 
 
Relative permeability to water at residual saturation of mobile fluid 
If the water is being injected into an oil bearing zone, this is the relative permeability of water at the 
residual oil saturation. For injection into aquifers, this value should be 1. 
Relative permeability to mobile fluid (oil/water) in virgin reservoir 
If the water is being injected into an oil bearing zone, this is the relative permeability of the oil. It 
should be taken as 1 for injection into an aquifer. 

 
 
 
4.2.4 Rock Mechanical Properties 
 

 
 
The appropriate mechanical properties need to be entered in consistent units. 

 
4.2.5 Rock Thermal Properties 
 

 
 

The appropriate thermal properties need to be entered in consistent units. 
 

4.2.6 Hydraulic Fracture Data for Fractured Injectors 
 
For approximate but long-term injectivity and fracture growth modeling of initially hydraulically 
fractured injectors, the following data is needed. The Fractured injector check box must be. For 
accurate but short term injectivity modeling of hydraulically fractured vertical injectors, the following 
data is needed under the frac-Packed Vertical Injector option: 
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For fractured injector without comprehensive frac-pack model, but allows frac pack extension the 
following input is required:   
 

 
 

 
 

 
 

4.3 Injection Stages 
 
Click the ‘Injection Fluid and Rate Data’ button. The program allows for multiple injection stages 
with varying injection fluid rheology, injection rates and water quality (solids and oil ppm).  

 

 
 
 

Initial Time 
Ten stages of injection are allowed. To enter multiple injection stages, click on the checkbox for the 
stage and enter the end time (number of days or pore volumes for core case) for that stage of 
injection. Note if you enter an end time less than the start time, you will be prompted to change it. 
 
Initial Injection rate 
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This is the initial rate at the start of the injection. If the user chooses ‘constant pressure injection’ in 
the ‘Core Flood Option’ (not provided in modeling injection via wells) as the flow constraint, the rate 
will decrease as injection proceeds.  Units:  m3/day [metric], bbl/day [field]. 1 m3/day = 6.2898224 
bpd 
 
Water density 
The density of the injection water.  Units:  kg/meter3 [metric], g/cc [field]. 1 kg/m3 = 0.001 g/cc 
 
Viscosity 
The injection fluid viscosity can be shear rate dependent (applicable to polymer injection wells). A 
power law model is used to represent the viscosity. A power law coefficient (k) and a power law 
exponent (n) at injection water temperature and at reservoir temperature are needed as inputs. For 

Newtonian fluids such as water, enter n = 1. Units for k:  cp.sn-1 [field]; n has no units. Please refer 

to ‘Enhanced Oil Recovery’ textbook by Larry W. Lake for reference. 
 
 
 
Particle Density 
The density of particles in the injection water. Particles of high density have a settling velocity when 
migrating through the pores, and their likelihood of being trapped is therefore, bigger. Organic 
materials (bacteria etc.) will have densities close to that of the water (~1.05 to 1.1 g/cc). Clay and 
mineral particles typically have densities between 2 and 3 g/cc. Units:  kg/m3, g/cc. 
 
Solids Concentration 
The volume fraction of suspended solids given in ppm. (parts per million, volume fraction of solids 
to the fluid).  Units:  ppm. 
 
Particle Size 
The particle size is a very important parameter in determining the filtration coefficient (deposition 

rate). If a particle size distribution is known, we suggest that a volume average be used.  Units:  m. 
 
Oil Droplet Density 
The density of oil droplets suspended in the injection water.  
 
Oil Droplet Concentration 
The volume fraction of suspended oil droplets given in ppm. (parts per million, volume fraction).  
Units:  ppm. 
 
Oil Droplet Size 
The suspended droplet size is an important parameter in determining the filtration coefficient 
(deposition rate). If a droplet size distribution is known, we suggest that a volume average be used 

to find the average droplet size.  Units:  m. 
 
Coalascent Fraction 
This is the fraction of injected oil droplets coalescing with the residual oil in the reservoir. The 
entrained oil droplets in the injected water behave differently from particles. All the particles 
entrained in the injected fluid contribute to plugging the formation. The oil droplets on the other hand 
can coalesce with the residual oil or may act like solid paticles by plugging the formation. The 
fraction of oil droplets coalescing with the residual oil do not contribute towards plugging. Hence, 
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only the remaining fraction of oil droplets are accounted for in particle plugging and permeability 
decline. The coalascent fraction depends on the interfacial properties of the rock and the fluids and 
can be estimated by history matching core flow tests. 
 
Filter Cake Properties 
In almost all the cases, a filter cake will ultimately start to build on the formation face after some 
time during injection. The properties (porosity and permeability) of the filter cake are assumed and 
are constant with time. The user can specify the porosity and permeability of the external filter cake. 
In case the data is unavailable, these can be calculated by the program by selecting the Automatic 
Evaluation box. The default value for the filter cake porosity is 0.25 and a corresponding permeability 
is calculated from the particle size using the modified Carman-Kozeny equation. Since the particles 
are treated as spheres, the permeability calculated is found to be an overestimate. Therefore, the 
calculated permeability is multiplied by 0.1 and used in the program. It is recommended that the 
estimates of external filter cake permeability be made by filtering the injection water through a 0.2 

m filter paper. 
 
 
 

                     
 
The program allows for multiple injection stages with varying water quality. Therefore, the filter cake 
properties need to be input for each stage. The number of stages corresponds to the number of 
stages selected previously in the Water and Particle Properties window. 



Chapter 5: Saving and Loading Data – File Menu 

 

29 

Chapter 5: Saving and Loading Data – File Menu 
 

5.1 Saving and Loading Data – File Menu 
 

The file menu in WID is similar to the file menu in most Windows programs. A description 
of each menu choice is given below. 
 
New 
When the users choose New, they are first asked to specify the well type (Vertical, 
horizontal or core flow test). Then a data input window appears. 
 
Open 
A dialog box where the user can select previously saved data files is displayed. Only one 
file can be open at a time. 
 
Save 
Saves the current input file to the default location. The first time a user chooses save, a 
default file name untitled.WID is used. Later save will use the previously chosen file name 
and will not prompt. 
 

Caution 

 

The default location for the data file is  

C:\Users\[userName]\Documents\WID\Datafiles 

 

The default location for the actual working folder is 

C:\Users\[userName]\Documents\WID\Output 

 

 
Save As   
Using this option always prompts the user for a file name and location. 
 
Close Project   
Closes the current file. 
 
Exit    
Exits WID. 
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Chapter 6: WID Units: Metric and Field 
 
The WID user interface allows a user to input parameters in either metric or oil field units. 
 

 6.1  Metric Units 

The metric units are based on the decimal system such as: centimeters, meters, 

and kilometers for length measurement; milligrams, grams, and kilograms for 

weight measurements; and cubic millimeters, cubic centimeters, and cubic meters 

for volume measurements. The metric units are evolving to SI units and are to be 

accepted internationally. However since the petroleum industry still uses metric 

system in its scientific literature that we are using metric units. 

           

6.2  Field Units 

The field units are the units used in the oil field industry. Some of the typical field 

units are as followed: barrel or gallon for volume measurement, ft or inches for 

length measurements, md or darcy for permeability measurements. 

 

6.3  Unit Conversion 

Below is the list of metric and field units used by the program along with their conversion 
factor.  

 
* Multiply the conversion factor with the values in metric units to obtain the corresponding value in 
field units. To obtain values in metric units from values in field units, multiply with the reciprocal of 
the conversion factor. 

Unit Type Metric Units Field Units Metric to Field 
Conversion * 

Length Meters Inches 39.370079 
Length Meters Feet 3.2808398 
Length Meters Microns 1e+6 
Perf. shot density Shots per meter Shots per foot 0.3047999 
Injection flow rate meter3/sec Bbl/day 543440.6587 
Density Kg/m3 g/cc 0.001 
Density kg/m3 lb/cu.ft 0.06242796 
Viscosity Pascal second Centipoise 1000 
Concentration m3/m3 ppm 1e+6 
Permeability m2 md 1e+15 
Pressure  Pascal psi 0.000145038 
Filtration coefficient 1/meter 1/cm 0.01 
Compressibility 1/Pascal 1/psi 6894.757 
Temperature Celsius Fahrenheit 1.8*C+32 
Specific heat KJ/Kg-K Btu/lbm-F 0.238186596 


